e

Computer Applications Il

San Pedro Junior College
Lecturer: Martin Santos




g % e
Import Excel Into Access 2016

* Open Access 2016/2019 database, click on the external data in the
ribbon and select Excel in the import & link command.

ACCESS 2016 ACCESS 2019
HDmE l:rEﬂtE E‘.-‘.‘I:EFr‘IEll Dﬂtﬂ DEtEhEE File Home Create External Data Database Tools Help D Tell me what you want to do

. ’T‘ '-;.Saved Imports = n

H iﬂ ﬂ_ ﬂ_ Uljﬂ" TE:{I: FIlE New+$ta g.red 0
’ | [ T @’ 1 . Source ~ Exports

| 3 XML File —
Saved Linked Tablgq Excel |Access ODE ﬁ s : -’? Excel
Imports  Manager Database  + More~ b Import Excel spreadsheet

3
_ L = .ﬂ"”mmc’ mport data from of link to data in a
Import & Link

Mlcru:u:u:uft Excel flle.
_b-‘ From Online Services . XML File
& 7

__E From Other Sources * u’ Text File
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Import Excel Into Access 2016

* In the file name, browse to the excel file which has to be imported into
the table.

Specify the source of the definition of the objects.

File name: | c:\Usersiwijay\Desktop\Tru.xlsx Browse...

* There are three ways in to specify how and where we need to store the
data in the current database.

* If we want to create a table and insert the imported Excel data into it,

check on import the source data into a new table in the current
database and click OK.
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Excel Info Access 20

Specify the source of the definition of the objects.

Eile name: | oo Usersivijay\Desktop\Tru.xlss

Specify how and where you want to store the data in the current database.

Browse...

@ Import the source data into a new table in the current database.

If the specified table does not exist, Access will create it. If the specified table already exists, Access might overwrite its
contents with the imported data. Changes made to the source data will not be reflected in the database.

O Append a copy of the records to the table: | Spheet

If the specified table exists, Access will add the records to the table, If the table does not exist, Access will create it,

Changes made to the source data will not be reflected in the database.

O Link to the data source by creating a linked table.

Access will create a table that will maintain a link to the source data in Excel. Changes made to the source data in Excel will

be reflected in the linked table, However, the source data cannot be changed from within Access,

Ok
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Import Excel Into Access 2016

o If your Excel spreadsheet has column headings mark the First Row

Contains.. check box; then hit Next. s EmEE

:}Ei_rst Row Contains Celumn Headings

* Then select each column to modity the field name and data type if

Field Options

needed.
e Hit Next

Data Type: Double v

o [] Do not import field (Skip)

Hame Marks [CGER
Iohn 0.5
Michel 7.4
mith .1
Bailey .9
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/Impor’r Excel Info Access 2016

* Now select if we need primary key option in your table.

* Select the, check on No primary key.

Microsoft Access recommends that you define a primary key for your new
uniquely identify each recard in yaur table. Tt allows you to retrieve datar

e Click Finish

= R ]
FaH R ]

(RN Hih e Choose my own primary key.
{iMNa primary key.

(@iet Access add primary key.

&

/

Marks |[CGER
55 6.5
74 7.4
il 5.1
4 o 4, O
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Relationships - Access 2016

* When you detine a relationship in Access, you relate data from one
table to another. By doing this, you are linking your tables together so

you can perform queries and extract specific data from multiple tables
all at once.

* There are three (3) types of relationships:

¥ CustomerID ey UL

First Name h"“‘ v Order D
—

1. A one-to-many relationship e ook >
City Ovder Date

2. A many-to-many relationship 26 Cod

3. A one-to-one relationship

One to Many |
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Relationships - Access 2016

e A primary key-foreign key relationship defines a relationship
between two tables in a database. A foreign key is a field in one table
that references the primary key in another table.

* To create a primary key-foreign key relationship one of the field must
be set as a primary key and both fields must be the same data type.
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Creating a Relatfionship

External Data Database Tools

o Click the Database Tools tab on the Ribbon ~ ~ -~ = - @

Direct Relationships

Show
Table 0B All Relationships

e From the Relationships group, click the = - "t

dit Relationship Report

A” ACCESS Ob_Je ¥« Relationships

Relationships icon. = o S

Tables Queries Both

= e
* A Design tab will appear = e

* For each table you want in the relationship,
click the table and then «click Add.
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Creating a Relatfionship

o After you finis

=5 Relationships

h adding tables, click the Close button.

R

Insurance

? Insurance Code
Insurance Company
Coverage

Patients

Visit

¥ Visit_ID
Registration Number
Date of visit
Health Centre Type
Blood Test
Insurance Code
Fees
G5T

v Reqgistration Mumber

Title

Last Mame
First Mame
Gender

Age
Address 1
Area

Date of Birth
Telephone
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Creating a Relationship

* Put the mouse pointer on the primary key field and click/hold the left
mouse button.

* While holding down the left mouse button, drag the mouse pointer to
the foreign key field

e

* Release the mouse button and a Edit Relationship dialog opens

Edit Relationships 7 *
Table/Query: Related Table /Query:
Patients Visit

Registration N1~ | Registration Num ~

Join Type..
W

Create Mew..
[CJEnforce Referential Integrity

Cascade Update Related Fields

Cascade Delete Related Records

Relationship Type: One-To-Many
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Creating a Relationship

* Double-check the both the field names (primary key field-foreign key

field) are the same from both tables.

® Check Enforce Referential Integrity, Cascade Update Related Fields,

Cascade Delete Related Records.
* Click Create to set the relationship

Edit Relaticnships

Table/Query: Related Table/Query:

Patients Visit

Registration M1~ Registration Mum) =~

L

Enforce Referential Integrity
Cascade Update Related Fields
Cascade Delete Related Records

Relationship Type: One-To-Many

? d
Cancel
Join Type..

Create Mew..
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Creating a Relatfionship

o After creating the relationships between all tables, Right Click on the

Relationships page tab, Click Save.

Right Click Here

‘_; Relationships

e

Visit

# Vvisit_ID
Registration Mumber

Health Centre Type
Elood Test

Fees
GST
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Queries Keywords / Tips

>

e SELECT - Show, Display

e APPEND — Add, Transfer

e UPDATE - Change, Edit

e DELETE — Remove, Erase

e PARAMETER — Prompt, Ask

cpeck oeh

Tips In Doing A Select Query

1) TABLES: What tables will be used?

2) FIELDS: Which fields will be used?

3) SORTING: Will there be sorting?

4) CRITERIA: What filtering /criteria will

be done? pe EFSY pS
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Query

Eight Features

View Options

Run Query Command
Object Relationship Pane
Design Grid

Field / Table Names
Sorting

Showing / Hiding Fields
Query Criteria

P NG LN =

e

HOME

B !

CREATE

EXTERNAL DATA

mEfEEiE

DATABASE TOOLS

(D Union % >
B Crosstab &2 Pass-Through

DESIGN

1 Update

\

Remembﬂ

View Run  Select Make Append : Query Show/
: ! Delete b Data Definition Setup ~ Hide
1 2 Table X Ueleie =, Usta Ue Setup * Hide
\i'e-f.u!tz Query Type
» I “H Queryt
Customers
g0
First Name
Last Name
Street Address
State
Zip Code
o Email
: Phone Number
o
< City
2 Add to Mailing List?
_g\ Other Notes
>
L]
=
O ———
5 F = — = —T I ]
’ Field: | First Name Last Name Street Address City Zip Code Du“ it
Table: | Customers Customers Customers Customers Customers
Sort: Ascending Q z FDHGET!
Show: v 4 ] v v —
Criteria: “Raleigh” § Y
or Not In ("276107)

Computer Applications II - San Pedro Junior College

16



L —
g —

)
Run Query 2
; Command

B After you have designed

Click the View drop-down arrow to switch to your query, click the Run

S e T e command to view the

and Design view. results of the queryin a

Datasheet view lets you view your query results in table.

the form of a table. Design view, featured here,

allows you to view and modify the design of your

query.

| B E F
el B~ Object Relationship Pane 3
5] Dottt view 1 All of the tables you choose to include in your query will

SQL 5Q View appear as small windows in the Object Relationship pane.
- Each window contains a list of every available field within that
B pesign view table.
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The Design Grid 4

The bottom part of Query Design view is called the
design grid. It contains a table that lists all of the
fields included in the query. Within this table, you

can set criteria to specify which information the
query should retrieve.

Sorting 6

You can sort the data retrieved by a query. Simply click in
the Sort: row of the field you want to sort, and select

either an Aseending or Descending sort. By default, query
results are not sorted.

Fields and Table Names | 2

The first row of the design grid contains
the names of the fields included in the
query. Directly beneath each field name

is the name of the table that field
belongs to.

Field: |First Name m
Table: st ormers SLOMErs
—
it

Criteria:

Field: | First Mame Last Mame Street Address
Table: [ Customers Customers Customers
: v
Criteria: Descending
on (not sorted)

Computer Applications II - San Pedro Junior College
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Showing and Hiding Fields
You may want to include fields in the design of your
query but hide them in the query results. To hide a field,
uncheck the checkbox in the Show: row of that field.

7

: Sort:
s
Lrtena

or:

Field: | First Name
Table: | Customers

vl

i
| Street Address
Customers

Query Criteria | 8

Entering query criteria lets you specify exactly what type of
information you want your query to retrieve. Simply type the
desired criteria in the Criteria: row of the field you want to search.
Here, the criteria has been set so that the query will search for
records with Raleigh in the City field and zip codes other than
27610.

o

Computer Applications II - San Pedro Junior College
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Basic Query Example

e Create a query that will display the patients first name, last name, registration
number, date of visit, health center type, area, insurance company. Sort the
query by last name then by first name in alphabetical order. Save the query as
PATIENTS INSURANCE.

1)  TABLES: What tables will be used? — Patients + Visits + Insurance

2) FIELDS: Which fields will be used? — first name, last name, registration number, date of visit, health center type, area, insurance company
3)  SORTING: Will there be sorting? — Yes, last name and first name (ascending)

4) CRITERIA: What filtering /criteria will be done? — None

Computer Applications II - San Pedro Junior College 20
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Query Criterio

ill only display items that are that exact value (replace the word value with

vhat you want to search by)

Is equal to

Less than
Less than or equal to

Greater than

Greater than or equal to

Iv

ot equal to

True only if both conditions exist

Ii

True if either condition exist

=
PN

True if the single instance is not true
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Examples of Query Ciriteria

>25 AND <50

GGMale??

Like A*

> 1000.00

applies to a Number field. It shows only those records where the field contains a value
greater than 25 and less than 50.

Applies to a short text field. It shows only those records where a field contains a value
equal to Male.

Applies to a short text field. It shows only those records where the field contains a value
that starts with the letter A

Applies to a number field. It shows only those records where the field contains a value
greater than 1000.00
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Query Example with Ciriteria

e Create a query that will only show the MALE patients first name, last name,
registration number, date of visit, health center type, area for San Pedrito only.
Sort the query by last name then by first name in alphabetical order. Save the
query as MALE SAN PEDRITO PATIENTS.

1)  TABLES: What tables will be used? — Patients + Visits

2) FIELDS: Which fields will be used? — first name, last name, registration number, date of visit, health center type, area
3)  SORTING: Will there be sorting? — Yes, last name and first name (ascending)

4)  CRITERIA: What filtering /criteria will be done? — Yes, gender = “Male” and area = “San Pedrito”
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Date Course Topics & Sub-topics Assessments Due Dates
Week 1 Go over course outline
*  Agsignment Of Accounts _
o ACCESS 2016 Elxerclsel 1: Import E?{cel—.ﬂ;ccess,
Importing Excel to Access Tables, Relationship FIElde FIEl'_j Properties, Records,
Previous Knowledge: Students know to create a RE&|ETIOHS!’IIF :
database. table. field, data type, set field properties) ﬁnmbtergrls Nathnal Bank
Week 2-4 Practical — 25 Points
Sort and Criteria to Select Queries 01/25/2019
Designing Calculated & Concatenated fields in a Select | g, o reise 2 — Parameters + Select
Query: Parameters Query Queries, Calculated &
Concatenated Fields.
Ambergris National Bank
Action Queries (Append, Delete, Update). Practical — 25 Points
Form: Creating a data entry form 01/31/2019
Reports: Creating reports from one table, multiple
tables, formatting reports, sorting, grouping, totals TEST 1: Import Excel-Access,
Relationship, Parameters + Select
Queries, Calculated &
Concatenated Fields
s IMPORT/EXPORT Practical Only — 100 Points
Week 5

Import/Export Betn. Office Applications

(Import Word Into, Access, Import Excel Into Access)
(Import Access Into Excel, Link Access/Excel To
Word)

02/01/2019

Exercise 3: Action Queries &

Reports
Practical — 25 Points
02/08/2019

Quiz 1: Access — Theory

(Tables, Field Properties,
Relationship, Queries & Reports)
Theory — 50 Points

02/14/2019
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Select Query

—

Calculated & Concatenated Fields

——
J—

icutated E jon in
calculate gxpress!
MS Access .
ribp,,ss-onsu-'de' = v&x'othc-:.-u ated .( : E:E‘
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Calculated Fields

To create a new calculated field
1. Indesign view, click on an empty field cell in the design grid

2. Give /type the name of the newly calculated field followed by a colon and
then the formula you wish to calculate. Refer to any existing fields by typing
their names surrounded by SQUARE BRACKETS.

3. Right click on the field and select properties to adjust number format and
decimal places.

4. Save the query
5. Click on the run query command button to view your results

Computer Applications II - San Pedro Junior College 26



| —

Calculated Fields

MATH OPERATORS

% Multiplication
- Addition

- Subtraction

/ Division

® For example: to calculate 5% of a salary field
® Bonus: [salary] * 0.05

Computer Applications II - San Pedro Junior College
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Calculated Field Example

e Create a query that will show the patient insurance company, last name, first name,
query p pany,

registration number, gender, fees. Sort by last name then by first name in alphabetical order

Show only the male patients who are insured by Warden. Do a calculated field, Discount,

that will calculated a 15% discount on the current fees. Save the query as FEES DISCOUNT.

Insurance Visit Patients
. BT T T e
Date of visit = First I
# Insurance Code st Name
Health Centre Type Gender
Insurance Company
Blood Test Age
Coverage
Insurance Code Address 1
Fees Area
GST - Date of Birth
Field: |Insurance Company Last Name First Name Registration Mumber Fees Discount: [Fees]*0.153
Table: |Insurance Patients Patients Patients Wisit
Sort: Ascending Ascending
Show
Criteria: |"warden"
or: |

Computer Applications II - San Pedro Junior College
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Concatenated Fields

To create a concatenated field
1. Indesign view, click on an empty field cell in the design grid

2. Give /type the name of the newly concatenated field followed by a colon and
then incorporate any text that will not change (including spaces) in quotation
marks. Use the ampersand (&) to join any two strings of text in the
expression. Refer to any existing fields by typing their names surrounded by
SQUARE BRACKETS.

3. Save the query
4. Click on the run query command button to view your results
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Concatenated Field Example

* Create a query that will show the patients’ registration number, fullname ( concatenated field
For Example: Santos, Martin), gender, date of visit, blood test. Sort by fullname in alphabetical
order and show only the patient that did a blood test. Save the query as PATIENT BLOOD

Patients Visit
* . * s
# Registration Mumbe 1 ¥ visitUD
Title Registration Numbe
Last Mame Date of visit
First Mame Health Centre Type
Gender Blood Test
- -
]
Field: |Registration Mumber | Fullname: [Last Mame] & ", " & [First Mame] | Gender Date of visit |Blood Test
Table: |patients Patients Wisit Visit
Sort: Ascending
Show:
Criteria: Yes
ar
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Parameter Query

Field:
Table:
Sort:
Show:
Criteria:
ar

Area
Patients

[What is the area?]

Enter Parameter Va...

What is the area?

OK

Cancel

Computer Applications II - San Pedro Junior College
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Parameter Query

* A parameter query Is one of the most useful queries you can create.
When you open a parameter query, Access will prompt you for a search
term and show you query results that reflect your search.

1. Create a select query.
2. In the criteria, enter a user prompt question in SQUARE BRACKETS.

Example

e Create a query that will ask the user for a search term to show only the particular health center type.
Show the patient registration number, fullname (concatenated field - last name, first name), gender,
date of visit, blood test, fees, tax (calculated field — 12.5% on fees), health center type. Show only
those patients that did a blood test. Save the query as BLOOD TEST BY HEALTH CENTER.
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Week 5

Action Queries (Append, Delete, Update).
Reports: Creating reports from one table, multiple
tables, formatting reports, sorting, grouping, totals

e IMPORT/EXPORT

Import/Export Betn. Office Applications

(Import Word Into Access, Import Excel Into Access)
(Import Access Into Excel, Link Access/Excel To
Word)

TEST 1: Import Excel-Access,
Relationship, Parameters + Select
Queries, Calculated &
Concatenated Fields

Practical Only — 100 Points
02/14/2019

Exercise 3: Action Queries &

Reports
Practical — 25 Points
02/21/2019

Quiz 1: Access — Theory

(Tables, Field Properties,
Relationship, Queries & Reports)
Theory — 50 Points

02/22/2019

e

Week 6-8

e EXCEL 2016
Copy / Paste Special; Filter
Excel Advanced Formulas
IF, VLOOKUP (Table Array), HLOOKUP.
CONCATENATE, Totals/Subtotals, Text To Columns
Charts: (Column, Bar, Line, Point, Pie)

Computer Applications II - San Pedro Junior College

TEST 2: Import Excel to Access —
Queries Action, Forms, Reports
Practical — 100 Points
03/01/2019
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Backup A Da’rabdse

1. Go to the File tab
2. Click on Save As
3. Select Backup Database

Save As

File Types Save Database As

Database File Types

@ Access Database (*.accdhb) [
Default database format.

Save Database As

Save Object As [#] Access 2000 Database (*.mdb) t
Save a copy that will be compatible with
Access 2000.
Advanced

[ g Package and Sign
Package the database and apply a digital
signature.

l;::‘? Back Up Database

Back up important databases regularly to
prevent data loss,

B.

Save As

NOTE: EVERYTIME you do an action query (Append, Update Delete), you must do a backup database to ensure
that you can recover from any mistakes.

Computer Applications II - San Pedro Junior College
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Enable Content

You need to Enable Content for your Action Query to run. If it not enabled, your action query
will not work properly.

You need to Enable Content for your Action Query to run. If it not enabled, your action query will
not work properly.

@’ - |+ start : Database (Access 2007 - 2010) - Microsoft Access
Home Create External Data Database Tools Acrobat
¢ Cut | Ascend L7 Selectic =i Ne % Totals 3 SacRep
- A l
53 Copy .| Descending V5] Advance =8 Save V Spelling 4 = Go To
: ) Filter i ) e . Refre - F Switch
t Paint t W Togale Filte : X Delete ~ =5 More ect * | Fit Form Windows ~
Views Clipboard M Sort & Filter Records Find Window
_!_ | Security Warning  Some active content has been disabled. Click for more details. Enable Content

Computer Applications II - San Pedro Junior College
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Make A Blank Copy Of Table

1
2
3
4.
5
0

. Hig
. Rig
. Rig

nlig
nt C

Nt Cli

IC

IC

From the
. Select Structure Only
. Click Ok

- e

Nt the table

K and Select Copy
kK and Select Paste

Paste Table As dialog. Give the table an appropriate name.

Table Mame: QK
Copy Of TOURIST
Paste Options Cancel
(®) Structure Only
() Structure and Data
(") Append Data to Existing Table

Computer Applications II - San Pedro Junior College 37



|
To Do An Append Query [m

Before Doing An Append Query, do a blank copy of the source table.  Carnt e
Go to Create — Queries, click Query Design, Select source tables and fields.
Go to Design tab - Query Type, click Append.

The Append dialog box appears.

In the Append To box, select the destination (target) table from the Table Name, select Current
Database and then click OK.

Example

e Create a query that will add only the San Mateo patients to a new table, Patients — San Mateo. Save the
query as SAN MATEO PATIENTS.

Append To

() Another Database:

AR A

' BACKUP BEFORE EACH |
| ACTION QUERY Do
I ' FORGET - M —

|
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To Do An Update Query

Go to Create — Queries, click Query Design, Select source tables and fields.
Go to Design tab, Query Type, click Update.
Select the field that you need to update.

In the Update to row, type out the formula to update the field. Note: You refer to any existing field
with SQUARE BRACKETS.

Example

e Create a query that will update the GST field in the Visits table with a 12.5% of the fees. Save the
query as FEES TAX.

B~ b

' BACKUP BEFORE EACH |
| ACTION QUERY  E—
I FORGET- =
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To Do A Delete Query

1. Go to Create — Queries, click Query Design, Select source tables and fields.

2. Go to Design tab - Query Type, click Delete.

3. Select a field that will determine what you delete.

4. Inthe Delete row, type out the criteria that will determine what records to delete from the table.
Example

e Create a query that will remove all the male patients from the San Mateo Patients table. Save the query
as DELETE SAN MATEO PATIENTS.

' BACKUP BEFORE EACH |
| ACTION QUERY Do
I . FORGET- =

Computer Applications II - San Pedro Junior College 40
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Import Word Into Access

1.  Copy each table to a separate Word document
2. Highlight each table and copy (Ctrl+C)
3. Paste it into a new word document (Ctrl+V)
4, Remove any rows that are blank, only header+records should remain. Remove any merge cells. Remove any commas in the table
5. Highlight the entire table and goto LAYOUT - Convert To Text
6. Select Commas and hit OK button .
7. GotoFILE - Save As Al E@ .|§| fx
8. In File name: type out the name of a table and Save As Type: Plain Text
9. At File Conversion dialog, hit OK Sort Hepeat— Convert Formula
10. (SAVE ALL CHANGES, CLOSE ALL DOCUMENTS AND - Header Fows  to Text
OPEN MICROSOFT ACCESS) Data
1. Create a blank database, MOH
2. Go to EXTERNAL DATA, Select Import Text File Saveas type: | Word Document
3. Select Import The Source Data Authors:Word Document
4. Select Delimited, Click Next ﬁg:g fe'ri‘;?gtgwme"t
5. Select Comma, and Click on First Row Contains Field Names Word Macro-Enabled Template
6.  Confirm the field names, Click Next (Note: Import Dates As Short Text) cFolders  |ppp | Templete
7. Select No Primary Key, Click Next Sl page
8. On Import To Table, Type out the table name WebPage
9.  Go to table — Design View and change the date field to from Short Text to Date/Time data type Rich Tedt Format
10.  Go to table — Datasheet View and delete any blank records o Docament
Word 2003 XML Document
Strict Open XML Document
OpenDocument Text
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Import Access Into Excel

AR A

6.

EXCEL 2016 EXCEL 2019

Important: Your Source Database MUST be closed

= [t R 1 1 o
Open Excel, Go to Cell Al malr 3 - = )
Go to Data - External Data - Select From Access Jfrom Fromfrom From Other -~
BT F ~ From Database ’ " From SQL Server Database
Select the database Dyt [N
At Import Data dialog, Click OK
(Note: If your database is not closed, you will get an error at step 5).
Got to Formulas - Name Manager, Edit e .
7. Set the name that you want to give the data, Click OK O et
15 O PivotChart
[! OgnIyCreate Connection
et
=5A51 55
O Mew worksheet
|:| Add this data to the Data Model
Properties... = Cancel
43
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Microsoft Excel
Spreadsheets
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RANK (Formula)

RANK displays the rank of a number in a list of numbers. It is particular useful in ranking students in a test
grade scenario. For Example: =RANK(B2.$B$6:$B$10.1)

=RANK (number, ref, [order])

Number: the cell address that you want to rank

Ref: The cell range (list of numbers) that it will be ranked against (usually absolute cell reference)

Order: [Optional] ascending (lowest to highest)/descending (highest to lowest) order specified by 1/0

Computer Applications II - San Pedro Junior College
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CONCATENATE (Formula)

When you concatenate cells in Excel, you combine only the contents of those cells. In other words,

concatenation in Excel is the process of joining two or more values together. This method is often used to
combine a few pieces of text that reside in different cells.

=CONCATENATE(celll,” “,cell2) OR =celll&” “&cell2
A | =CONCATENATE(C3,",",B3} f || =c3g" "&B3
B C D B T D
:;r:lte Last Name Full Name :;r:lte Last Name Full Name
Jane Doe Dog, Jane nl Jane Doe Dae, Jane
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TEXT TO COLUMNS

In Excel, a user can take the text in one or more cells, and split it into multiple cells using the Convert
Text to Columns.

Select the cell or column that contains the text you want to split.
Select Data > Text to Columns.
In the Convert Text to Columns Wizard, select Delimited > Next.

Select the Delimiters for your data. For example, Comma and Space. You can see a
preview of your data in the Data preview window.

Select Next.

Select the Column data format or use what Excel chose for you.

Select the Destination, which is where you want the split data to appear on your worksheet.
Select Finish.

B e

© N o O
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IF

IF is usedto create conditional arguments by testing a condition that is either true or false.

=[F(logical test, value if true, value if false)

\\ &

Function Condition Instructions
It can be used with the following operatorsin the condition section of the formula
Operator Meaning
> Greater Than
= EqualTo
== Greater than or equal to
< Less than
<= Less than or equal to
<= Not equal to

Computer Applications II - San Pedro Junior College
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